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设设计计指指南南：：TIDM-1000
基基于于 Vienna 整整流流器器且且采采用用 C2000™ MCU 的的三三相相功功率率因因数数校校
正正 (PFC) 参参考考设设计计

说说明明

Vienna 整流器电源拓扑用于高功率三相功率因数校正

应用 （如非车载电动车辆 (EV) 充电器和电信整流

器）。整流器的控制设计可能很复杂。此设计指南使用

C2000 ™微控制器 (MCU) 说明了控制功率级的方法。

还根据 HTTP GUI 页面和以太网支持（仅 F2838x）实

现了对 Vienna 整流器的监测和控制。可供此设计使用

的硬件和软件可帮助您缩短产品上市时间。

资资源源

TIDM-1000 设计文件夹

TMS320F28379D 产品文件夹

TMS320F280049C 产品文件夹

TMS320F28388D 产品文件夹

UCC21520DW 产品文件夹

AMC1301 产品文件夹

咨询我们的 E2E 专家

特特性性

• 三相输入 208 VL-L 60Hz，输出 600V 直流（标称

值），1.2KW

• 三相输入 400 VL-L 50Hz，输出 700V 直流（标称

值），2.4KW

• 50kHz 脉宽调制 (PWM) 开关

• 峰值效率高于 98%

• 满负载和低压线路中的总谐波失真 (THD) 小于 2%

• 提供 powerSUITE 支持，以使设计轻松适应用户要

求

• 具有软件频率响应分析器 (SFRA) 和补偿设计器，便

于控制环路调优

• 使用驱动程序库为 F2838x、F2837x 和 F2804x 提

供软件支持。能够在保持相同源代码的情况下基于

C28x 或 CLA 运行控制环路。

• 根据 HTTP GUI 页面和以太网支持（仅 F2838x）监

测和控制 Vienna 整流器

应应用用

• 用于 EV 的非车载充电器

• 电信整流器

• 驱动器、焊接和其他工业应用

http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf
http://www.ti.com.cn/tool/cn/TIDM-1000
http://www.ti.com.cn/product/cn/TMS320F28379D
http://www.ti.com.cn/product/cn/TMS320F280049C
http://www.ti.com.cn/product/cn/TMS320F28388D
http://www.ti.com.cn/product/cn/UCC21520
http://www.ti.com.cn/product/cn/amc1301
http://e2echina.ti.com
http://e2e.ti.com/support/applications/ti_designs/
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该 TI 参考设计末尾的重要声明表述了授权使用、知识产权问题和其他重要的免责声明和信息。

1 系系统统 说说明明

工业应用中以高功率运行的设备使用三相 电源。为了提高电网电力质量并降低消耗的谐波电流，需要使用功

率因数校正，因为许多前向负载是直流电。例如，在非车载快速 EV 充电器中，在以 20KW 功率运行的情况

下，输入是来自电网的三相交流电，输出是流入电池的直流电。

虽然用于有源三相功率因数转换的拓扑非常之多，但 Vienna 整流器仍然颇受青睐，因为它以连续导通模式

(CCM) 运行，具有固有的多级开关（三级），并且可以降低功率器件上的电压应力。Vienna 整流器通常会

使用基于迟滞的控制器。直到最近，基于正弦三角的 PWM 才被用于 Vienna 整流器控制。该控制的设计可

能非常具有挑战性。Vienna 整流器具有多种变体，图 1 显示了该设计中选用的 Vienna 整流器变体以及所感

应的主要电压和电流。

图图 1. 实实施施的的 Vienna 整整流流器器变变体体

此设计指南实施了 Y 连接 Vienna 整流器。此设计旨在举例说明如何使用 C2000 MCU 控制 Vienna 整流器

并对不同环路进行调优。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf
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1.1 主主要要系系统统级级规规格格

表 1 中提供了三相 Vienna 整流器主要电源规格。

表表 1. 主主要要系系统统规规格格

参参数数 规规格格

输入电压 (Vin)
• 交流 208Vrms VL-L 或 120Vrms L-N，60Hz
或

• 交流 400Vrms VL-L 或 230Vrms L-N，50Hz
输入电流 (Iin) 4 安培 RMS 最大值

输出电压 (Vout)
• 600V 直流总线标称值 (208Vrms)
或

• 700V 直流总线标称值 (400Vrms)
输出电流 (Iout) 绝对 RMS 最大 5 安培，脉冲最大 10 安培

额定功率
• 1.2KW（三相 208Vrms）
或

• 2.4KW（三相 400Vrms）

电流 THD • 小于 1%（额定负载，208Vrms）
• 小于 4%（额定负载，400Vrms）

效率 峰值 98%，平均值约 97%
初级滤波电感器 3mH
输出电容 180µF
PWM 开关频率 50kHz

WARNING
按按照照 TI 的的计计划划，，该该 EVM 仅仅可可在在实实验验室室环环境境中中运运行行，，并并未未
考考虑虑将将其其用用作作成成品品 以以供供消消费费使使用用。。

按按照照 TI 计计划划，，该该 EVM 仅仅可可由由熟熟悉悉处处理理高高电电压压电电子子和和机机械械
组组件件、、系系统统及及子子系系统统所所存存在在的的相相关关风风险险的的合合格格工工程程师师和和技技术术
人人员员 使使用用。。

电电路路板板中中存存在在可可接接触触的的高高电电压压。。如如电电路路板板的的电电压压和和电电流流处处理理
不不当当或或施施加加不不正正确确，，则则将将可可能能导导致致电电击击、、火火灾灾或或伤伤害害。。使使用用
该该设设备备时时应应特特别别小小心心，，并并采采取取相相应应的的保保护护措措施施，，以以避避免免伤伤害害
自自己己或或损损坏坏财财产产。。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf


Vienna Rectifier

C2000 Microcontroller

TMS320F2837xD

3 x AMC1301

3 x

 UCC21520DW

Three Phase 

AC
Filter

3x OPA320

DC Output

1 xOPA43501xDCH010505SN7

2x AMC1301

2x OPA320

1xDCH010505SN7

V1N2,N,3N

iL1,L2,L3

VBusMN

VBusPM

!

系统概述 www.ti.com.cn

4 ZHCU271E–November 2016–Revised June 2019

TIDUCJ0 — http://www-s.ti.com/sc/techlit/TIDUCJ0
版权 © 2016–2019, Texas Instruments Incorporated

基于 Vienna 整流器且采用 C2000™ MCU 的三相功率因数校正 (PFC) 参考设
计

CAUTION

请请勿勿在在无无人人照照看看的的情情况况下下使使 EVM 通通电电。。

高高电电压压！！ 电电路路板板中中存存在在可可接接触触的的高高电电压压。可能发生电击。如电路

板的电压和电流处理不当，则可能会导致电击、火灾或伤害。使

用该设备时应特别小心，并采取相应的保护措施，以避免伤害自

己或损坏财产。为安全起见，强烈建议使用具有过压和过流保护

的隔离式测试设备。

TI 认为在对电路板通电或进行仿真之前，用户有责任确认自己已

明确并理解了电压和隔离要求。通通电电后后，，请请勿勿触触摸摸 EVM 或或与与

EVM 相相连连的的组组件件。

表表面面高高温温！！接接触触可可能能会会导导致致烫烫伤伤。。请请勿勿触触摸摸！！

电路板加电后，某些组件可能会达到 55°C 以上的高温。在运行

过程中或运行刚结束时，用户不得触摸电路板，因为可能存在高

温。

2 系系统统概概述述

2.1 方方框框图图

图 2 显示了该设计中选用的 Vienna 整流器的方框图以及所感应的主要电压和电流。

图图 2. 方方框框图图

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf
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2.2 主主要要产产品品

2.2.1 C2000™ MCU F2838x、、F2837x 和和 F28004x

C2000 MCU 是经优化的 MCU 系列，适用于实时控制 应用。快速且高质量的模数控制器可实现精确的电流

和电压信号测量，集成比较器子系统 (CMPSS) 集成了过流和过压保护，无需使用任何外部器件。经优化的

CPU 内核可快速执行控制环路。使用片上三角函数数学单元 (TMU) 对三角函数运算进行了加速，该单元可

以进一步加快控制环路执行进程。该解决方案还提供了在 F28004x、F2837x 和 F2838x 上使用控制律加速

器 (CLA) 的选项。CLA 是一款协处理器，可用于减轻 CPU 负载并支持在 C2000 MCU 上运行更快的循环和

/或更多的函数。

2.2.2 UCC21520

UCC21520 是一款隔离式双通道栅极驱动器，具有 4A 峰值拉电流和 6A 峰值灌电流。该驱动器可用于驱动

高达 5MHz 的功率 MOSFET、IGBT 和 SiC MOSFET，具有一流的传播延迟和脉宽失真度。输入侧通过一

个 5.7kVRMS 增强型隔离栅与两个输出驱动器隔离，共模瞬态抗扰度 (CMTI) 的最小值为 100V/ns。两个次

级侧驱动器之间的内部功能隔离支持高达 1500V 的直流工作电压。禁用引脚在设为高电平时可同时关断两

个输出，在悬空或接地时允许器件正常运行。此器件支持高达 25V 的 VDD 电源电压。凭借 3V 到 18V 的宽

输入电压 VCCI 范围，该驱动器非常适合同时连接模拟和数字控制器。

2.2.3 AMC1301

AMC1301 是一款精密隔离放大器，通过磁场抗扰度较高的隔离栅隔离输出和输入电路。AMC1301 输入针

对直接连接分流电阻器或其他低电压电平信号源进行了优化。

2.2.4 OPA320

OPA320 是一款经优化的精密、低功耗、单电源运算放大器，可实现极低的噪声。该器件在1.8 至 5.5V 的

电压范围内运行，非常适合驱动模数转换器 (ADC)。凭借 40µV 的典型失调电压和极低的温漂（典型值为

1.5μV/°C），该器件非常适合电机控制中控制环路和电流感应等 应用 。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf
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3 控控制制系系统统设设计计原原理理

本节介绍控制系统设计原理

3.1 PWM 调调制制

图 3 显示了 Vienna 整流器的简化单相图。要控制该整流器，需要对占空比进行控制，从而使其直接调节电

压 vxiN。也就是说，如果软件变量 Duty 设置为 1，则会始终禁止打开 Q1 和 Q2 开关并将电感器通过桥式二

极管连接至直流总线，从而让 vxiN 成为可能的最大电压。同样，如果 Duty 设置为 0，则会对 PWM 进行调

制，始终保持 Q1 和 Q2 导通，让 vxiN 连接至直流总线的中点（其值为零），从而令其成为开关周期内可能

的最低电压。

图图 3. Vienna 整整流流器器的的单单相相图图

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf
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图 4 显示了详细的 PWM 配置。

图图 4. Vienna 整整流流器器详详细细 PWM 调调制制方方案案

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf
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3.2 电电流流环环路路模模型型

要了解电流环路模型，应首先仔细查看电感器电流。在图 5 中，为连接到开关 Q1 和 Q2 的 PWM 调制器提

供了占空比 D。明白这一点后，请查看公式 1：

(1)

注注: 当 D 设置为 1 时，所有开关关闭，当 D 为 0 时，所有开关打开，这会将电感器连接至 M 点。

要调制流经电感器的电流，应使用 Q1 和 Q2 开关的占空比控制调节电压 vxiN。假设电流的方向沿从交流线

路到整流器的方向为正并使用直流总线前馈和输入交流电压前馈，同时假设电网的阻抗相当小。电流环路可

简化为如图 5 所示，并且可以将电流环路受控体模型表达为公式 2 所示。

(2)

其中：

• Kv_gain 是总线和交流输入最大感应电压的倒数，即 1/Vmax_sense。假设交流电压最大感应值和直流总线电压

最大感应值相等。

• Ki_gain 是最大交流感应电流的倒数。

• Ki_fltr 是从电流传感器连接到 ADC 引脚的 RC 滤波器的响应。

• Gd 是与 PWM 更新和数字控制相关联的数字延迟。

• iLi
* 是电流命令，iLi 是实际电感器电流。

• Vbus/2 是某一输出总线电容器上的电压。

• Zi 是包含电感 Li 和电阻 Ri 的电感器的阻抗。

• Hp_i 是数字控制器 Gi 控制的电流环路受控体。

• viN 是输入端的瞬时交流电压。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf
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图图 5. 电电流流环环路路控控制制模模型型

注注: 由于电流环路被视为对电压 vxiN 进行调节，因此在参考上的相应位置使用了负号。要增大电
流，必须降低 vxiN，因此在图 5 中，将基准电压和电压反馈标记了“+”号。该电流环路模型用于
调节电流补偿器。该电流环路使用了一个简单比例控制器。会对比例增益进行调节，以确保系
统稳定。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf
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3.3 直直流流总总线线调调节节环环路路

假设直流总线调节环路提供基准电源。该环路除以线电压 RMS 的平方，可得出电导率，然后再乘以线电

压，以提供瞬时电流命令。

通过围绕运行点对公式 3 进行线性化来形成直流总线调节环路的小信号模型。

(3)

对于电阻负载，总线电压与电流相关，如公式 4 中所示。

(4)

可以画出直流电压调节环路模型，如图 6 中所示。施加了额外的 Vbus 前馈，以使控制环路独立于总线电

压，因此总线控制的受控体模型可表达为公式 5 所示。

(5)

其中：

• Hp_bus 是数字控制器 Gv 控制的电压环路受控体。

• Gv 的输出是功率基准 Po
*

• vbus
* 是电压命令/基准，vbus 是实际总线电压。

• Co 是输出电容器，RL 是负载电阻。

借助图 6，为该电压环路设计了一个比例积分器 (PI) 补偿器。由于该环路的带宽在稳态下与 THD 相冲突，

因此保持在较低水平。

图图 6. 直直流流电电压压环环路路控控制制模模型型

http://www.ti.com.cn
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此外，还使用了非线性 PI 环路来降低阶跃负载变化时产生的瞬态。图 7 显示了在该设计中实现的非线性 PI
环路的结构。

图图 7. 电电压压控控制制器器的的非非线线性性 PI 环环路路

http://www.ti.com.cn
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3.4 直直流流电电压压平平衡衡控控制制器器

在 Vienna 整流器中，针对输出电压总线使用了一个分裂电容器。这些电容器上的电压可能不会自行保持平

衡，因此添加了直流平衡控制器环路。该环路可对失调电压进行调制，并将其添加至占空比，因此对流经中

点的电流进行调制，以平衡分裂电容器上的电压。

针对直流总线平衡控制器使用了简单比例增益，其平衡环路的输出可通过公式 6 计算得出。

(6)

4 硬硬件件设设计计原原理理

下面是有关该设计中使用的电感器、输出电容器和感应方案选择的详细信息。有关其中每项的更多详细信

息，请参阅软件安装包中的 Excel 工作表。

C2000Ware_DigitalPower_SDK_<version>\solutions\tidm_1000\hardware\

calculations.xlsx

4.1 电电感感器器设设计计

输入电感器 (Li) 会过滤掉开关频率谐波。除其他因素之外，电感器设计还与电流纹波计算值和内核为承受计

算出的电流纹波而选用的材料相关。图 8 显示了一个开关周期波形内逆变器输出电压 vi 与电感器电流的关

系。

图图 8. 电电流流纹纹波波计计算算

http://www.ti.com.cn
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电感器上的电压由 V = Li(di/dt) 给出。对于 Vienna 整流器，请参阅公式 7。

(7)

其中 Ts = 1/Fsw 是开关周期，D’ 是开关处于接通状态的占空比。对于控制设计，假设 D 是电感器的另一个

端子处的电压，它与 D’ 的关系为 D’ = 1 - D。在交流波形中的任何时刻对电流纹波的重新排列根据公式 8 得

出。

(8)

现在，假设调制指数为 ma，则占空比可由 D' = ma*sin(wt) 给出，假设 viN=D'*(Vbus/2)，则可以推导出公式

9。

(9)

通过公式 9，可以清楚地看到，峰值纹波是一个因数，其中输入交流电具有正弦波形。

要获取相对于时间使公式差异化的最大值，请使用公式 10。

(10)

该公式提供了 sin(wt)=1/(2*ma) 中存在的最大纹波，替换该值，可以推导出公式 11。

(11)

得到这些值后，可以选择相应的内核以及符合该电感值的电感器。

4.2 总总线线电电容容器器选选择择

总线电容器负责消除直流电压上可能由正弦电流消耗导致的纹波。电容器值和直流总线纹波之间的关系由公

式 12 给出。

(12)

该公式用于选择最小直流总线电容值。

注注: 虽有上述计算，但仍需以电容器超裕度设计标准为准。电容器大小调整更依赖于负载及其消耗
的电流的性质。对于三相 PFC，电源纹波相当小，因为输入始终具有到达输出的路径。因此，
上面的公式仅作参考，并请明白实际使用时需要以超裕度设计标准为准。

http://www.ti.com.cn
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4.3 输输入入交交流流电电压压感感应应

首先，使用以 Y 方式连接的电阻器网络以及某个用于实现稳定性的电容构建虚拟中性点。在该设计中，控制

器保持位于冷侧，因此使用隔离式放大器 AMC1301 来处理 VL-N’ 电压，如图 9 中所示。由于在设计

AMC1301 时考虑了用于电流感应应用的低阻抗源，因此输入差动电阻在总增益计算中扮演非线性角色。因

此，在版本级别一中必须完成最终校准，并且必须根据校准调节最大交流电压范围。或者，可以使用 TINA-
TI™ 软件进行仿真。

图图 9. 输输入入交交流流电电压压感感应应

4.4 总总线线电电压压感感应应

类似地，使用 AMC1301 和 OPA320 感应在两个电容器之间进行分摊的总线电压，如图 10 中所示。

图图 10. 总总线线电电压压感感应应

由于精确度在总线电压感应中具有重要的作用，因此通过执行回归分析执行进一步的偏移校准和增益调节。

安装包中的 Excel 工作表中显示了如何实现此效果的样例，该工作表文件的名称为：

C2000Ware_DigitalPower_SDK_<version>\solutions\tidm_1000\hardware\BusMeasCalibrationRoutine.xlsx

• 工作表 -> calData（这是用于运行回归的原始数据）

• 工作表 -> PM_Reg

• 工作表 -> MN_Reg（这些是运行回归的结果，为测量调节提供了截距和增益值）

http://www.ti.com.cn
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4.5 电电感感器器电电流流感感应应

使用霍尔效应传感器来感应流经电感器的电流。霍尔效应传感器具有内置失调电压，且该失调电压的范围不

同于 ADC 可以测量的范围。因此，使用图 11 中所示的电路对电压进行调节，以匹配 ADC 范围。

图图 11. 使使用用霍霍尔尔效效应应传传感感器器进进行行电电流流感感应应

4.6 感感应应滤滤波波器器

在连接到逆变器之前，使用 RC 滤波器对信号进行滤波。在该设计中为所有感应信号使用了一个共用 RC 滤

波器，如图 12 中所示。

图图 12. RC 滤滤波波器器

4.7 保保护护 (CMPSS)

大多数电力电子转换器需要过流事件保护。对于该设计，需要多个比较器，并且必须为跳闸生成基准，如图

13 中所示。

图图 13. 使使用用比比较较器器和和基基准准生生成成器器为为 PWM 生生成成跳跳闸闸

http://www.ti.com.cn
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借助 TMS320F28379D 和 TMS320F280049C 等 C2000 MCU 即可避免使用所有这些电路，这些 MCU 具

有作为 CMPSS 一部分的片上窗口比较器，它们在内部连接到 PWM 模块，可以实现 PWM 快速跳闸。该器

件可在最终应用中节省布板空间并且具有成本效益，因为可以通过使用片上资源避免额外的组件，如图 14
中所示。

图图 14. 用用于于过过流流保保护护的的比比较较器器子子系系统统 (CMPSS)

4.8 效效率率估估算算

C2000Ware_DigitalPower_SDK_<version>\solutions\tidm_1000\hardware\calculations.xlsx 中

显示了预期效率估算值

• 工作表 → Efficiency Estimate

5 硬硬件件入入门门

本节详细介绍硬件并说明电路板上的不同部分。如果单独通过 powerSUITE 使用该设计的固件，则本节将不

适用。

5.1 基基板板设设置置

该设计遵循 HSEC 控制卡理念。任何可以通过 C2000 MCU 产品系列提供 HSEC 控制卡的器件都可能用于

该设计。表 2 中列出了 MCU 上用于控制功率级的重要资源。图 15 显示了设计指南上的主要功率级和连接

器，表 3 列出了主要连接器及其功能。着手实施时，请执行以下步骤：

1. 确保没有电源连接到该设计。

2. 在 J8-J10 插槽中插入控制卡。

3. 在 J11 和 J12 处插入跳线，以连接 5V 和 3.3V 偏置电源。

4. 在 J4 处连接 12V 直流 1 安培电源。基板上的一些 LED 将亮起，以指示电源。控制卡上的 LED 也将亮
起。该灯指示器件也已加电。

注注: MCU 的偏置与功率级是分离的，从而可以安全地启动系统。

5. 要连接 JTAG，请使用 USB 电缆连接控制卡和主机。

6. 一个三相电源连接到输入 J2。该电路板作为三线系统工作，因此不要求中性点连接。会在电路板上生成
虚拟中性点，用于感应 VL-N 电压。

7. 还应将大约 500Ω 的电阻负载连接至 J1 处的输出。负载连接在正负端子 (Vbus) 上。中点 (M) 未连接至
负载。

http://www.ti.com.cn
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8. 可以连接电流和电压探针，以观察输入电流、输入电压和输出电压，如图 16 中所示。

图图 15. 电电路路板板概概述述

表表 2. 电电路路板板上上用用于于控控制制功功率率级级的的主主要要控控制制器器外外设设

信信号号名名称称 HSEC 引引脚脚编编号号 功功能能

PWM-1A 49 PWM：Vienna 整流器 PWM Ph1A
PWM-1B 51 PWM：Vienna 整流器 PWM Ph1B
PWM-2A 53 PWM：Vienna 整流器 PWM Ph2A
PWM-2B 55 PWM：Vienna 整流器 PWM Ph2B
PWM-3A 50 PWM：Vienna 整流器 PWM Ph3A
PWM-3B 52 PWM：Vienna 整流器 PWM Ph3B

IL1 15、20 具有 CMPSS 的 ADC：电感器电流测量 Ph1
IL2 21、27 具有 CMPSS 的 ADC：电感器电流测量 Ph2
IL3 25 具有 CMPSS 的 ADC：电感器电流测量 Ph3
V1 18 ADC：交流电压感应 Ph1
V2 28 ADC：交流电压感应 Ph2
V3 34 ADC：交流电压感应 Ph3

Vbus_PM 31、24 ADC：总线电压正端子连接到中点

Vbus_MN 37、26 ADC：总线电压中点连接到负端子

性能评测 GPIO1 58 GPIO：用于对代码进行性能测评（可选）

性能评测 GPIO2 60 GPIO：用于对代码进行性能测评（可选）

http://www.ti.com.cn
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表表 3. 主主要要连连接接器器和和功功能能

连连接接器器名名称称 功功能能

J1 输出高电压总线

J2 输入三相电压

J3 中性点和接地连接

J4 输入偏置电源，12V 直流 1 安培

J5 用于调试的 DAC 输出

J6 接地

J7 性能评测 GPIO 连接器

J8、J10 HSEC 控制卡连接器槽

J9 远程启用连接器

J11 5V 跳线，用于断开 5V 电源

J12 3V 跳线，用于断开 12V 电源

图图 16. 用用于于运运行行软软件件的的硬硬件件设设置置

http://www.ti.com.cn
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5.2 控控制制卡卡设设置置

需要对器件控制卡进行某些设置以通过 JTAG 进行通信并使用隔离式 UART 端口。这些设置还提供正确

的 ADC 基准电压。下面是需要对 F28388D 控制卡修订版 1.1 进行的设置。请参阅位于 C2000Ware 内

的信息工作表，其位置为

<sdk_install_path>\c2000ware\boards\controlCARDs\TMDSCNCD28388D：

1. 必须在两端将控制卡上的 S1:A 设置到打开 位置，以实现到器件的 JTAG 连接以及 SFRA GUI 的 UART
连接。如果该开关处于关闭 位置，则无法使用控制卡上的内置隔离式 JTAG，SFRA GUI 也无法与器件
进行通信。

2. J1:A 是适用于 USB 电缆的连接器，该电缆用于实现运行 Code Composer Studio (CCS) 的主机 PC 与
器件之间的通信。

3. 根据 C2000ware 内部 TMDSCNCD28388D 用户指南，在调试模式下使用 CCS 和 onCard xds100v2 仿
真器时，建议将 S2 设置为将 C2000 器件切换到等待模式，这样可降低连接问题发生的风险：位置 1：
关闭，位置 2：开启。

4. 需要为打开该设计的控制环路使用 3.3V 基准；因此，设置相应的跳线以在外部为片上 ADC 提供 3.3V
基准。对于 1.3 版 F28388D 控制卡而言，这意味着使用“.”将 S3 和 S4 移至末尾，即在左边放置 3.3V
VDDA 作为 ADC 的基准。有关更多信息，请参阅信息工作表。

需要对器件控制卡进行某些设置以通过 JTAG 进行通信并使用隔离式 UART 端口。这些设置还提供正确的

ADC 基准电压。下面是需要对 F28379D 控制卡的修订版 1.1 进行的设置。请参阅位于 C2000Ware 内的信

息工作表，其位置为

<sdk_install_path>\c2000ware\boards\controlCARDs\TMDSCNCD28379D：

1. 必须在两端将控制卡上的 A:SW1 设置到打开（向上） 位置，以启用到器件的 JTAG 连接以及 SFRA
GUI 的 UART 连接。如果该开关处于关闭（向下） 位置，则无法使用控制卡上的内置隔离式
JTAG，SFRA GUI 也无法与器件进行通信。

2. A:J1 是用于 USB 电缆的连接器，该电缆用于运行 Code Composer Studio (CCS) 的主机 PC 与器件之
间的通信。

3. 需要为打开该设计的控制环路使用 3.3V 基准；因此，设置相应的跳线以在外部为片上 ADC 提供 3.3V
基准。对于 1.3 版 F28379D 控制卡而言，这意味着使用“.”将 SW3 和 SW2 移至末尾，即在左边放置
3.3V VDDA 作为 ADC 的基准。有关更多信息，请参阅信息工作表。

需要对器件控制卡进行某些设置，以通过 JTAG 进行通信并使用隔离式 UART 端口。用户还必须提供正确

的 ADC 基准电压。下面是修订版 A TMS320F280049C 控制卡所需的设置（请参阅信息列表，位置位于

<sdk_install_path>\c2000ware\boards\controlCARDs\TMDSCNCD280049C。

1. 将控制卡上 S1:A 的两端设置到打开（向上）位置，以启用到器件的 JTAG 连接以及 SFRA GUI 的
UART 连接。如果该开关处于关闭（向下）位置，则用户无法使用控制卡上的内置隔离式 JTAG，SFRA
GUI 也无法与器件进行通信。

2. 将 USB 电缆连接到 J1:A，以实现运行 CCS 的主机 PC 与器件之间的通信。

3. 对于控制环路，请使用 TMS320F28004x 的内部基准并将 S8 开关移到左侧（即指向 VREFHI）。

4. 为了使该参考设计实现最佳性能，请移除控制卡上隔离式接地端之间连接的电容器 C26:A。
5. GPIO24 通过 GPIO27 在 TMS320F280049C 控制卡上实现复用。将 SW5 上的所有开关切换至关闭

（向上），并将 SW6 上的所有开关切换至打开 （向上）。

http://www.ti.com.cn
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6 固固件件入入门门

该设计的软件在 C2000Ware_DigitalPower_SDK 中提供，在 powerSUITE 框架内受到支持。

注注: 两种 TMS320F28379D 和 TMS320F280049C 器件均支持该解决方案用固件。

6.1 在在 Code Composer Studio™ 中中打打开开项项目目

要开始，请执行以下步骤：

1. 安装 CCS（版本 9.0.1 或以上）。

2. 打开 CCS。
3. 转到 View → CCS App Center。
4. 在 Code Composer Studio Add-ons 下，确保已安装 GUI Composer Runtime。如果未安装 GUI，则安

装 GUI Composer Runtime。
5. 安装适用于 C2000 微控制器的 DigitalPower 软件开发套件 (SDK) 工具文件夹内的 C2000Ware

DigitalPower SDK。

注注: 在进行默认安装时，powerSUITE 随 DigitalPower SDK 一起安装。

6. 关闭 CCS，然后打开新的工作区。

7. 关闭 CCS，然后打开新的工作区。CCS 将自动检测 powerSUITE。可能需要重新启动 CCS 才能使更改
生效。

8. 转到 View → Resource Explorer。在 TI Resource Explorer 下，转到软件 → C2000Ware DigitalPower
SDK - <版本>。

按原样打开设计指南软件（以固件在该设计和硬件上运行的方式打开固件，要求电路板与该设计指南完全相

同，不允许通过项目内的 powerSUITE GUI 进行修改）。

1. 在 C2000Ware DigitalPower SDK 下，选择开发套件 → 三相 PFC Vienna 整流器 TIDM-1000，然后单
击运行 <器件> 项目。

2. 这将导入项目和开发套件，或者将显示设计页面。该页面可用于浏览有关该设计的所有信息，包括该用
户指南、测试报告、硬件设计文件等。

3. 单击 Run <device_name> Project。
4. 这会将项目导入到工作区环境中，并显示具有与图 17 类似的 GUI 的 cfg 页面。

注注: 由于该项目是从开发套件和设计指南页面导入的，因此不允许通过 GUI 修改功率级参数。

5. 如果该 GUI 页面不显示，请参阅 C2000Ware DigitalPower SDK 资源浏览器中 powerSUITE 下的“常见
问题解答”部分。

http://www.ti.com.cn
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打开要改编的设计指南软件。用户可以修改功率级参数，然后这些参数用于在补偿设计器中创建功率级模

型，并且还可以修改电压和电流的调节值。

1. 在资源浏览器中的 C2000Ware DigitalPower SDK powerSUITE 下，单击解决方案适配器工具 ( )。
2. 从显示的解决方案列表中选择 三相 PFC。

3. 在下一页中选择该解决方案需要运行的器件。

4. 单击图标后，会显示一个弹出窗口，询问要创建项目的位置。您也可以在工作区内保存项目。指定位置
后，即可创建项目，并会显示 GUI 页面和适用于该解决方案的可修改选项（图 17）。

5. 您可通过 GUI 为调整后的解决方案更改参数，例如额定功率、电感、电容、感应电路参数等。

6. 如果该 GUI 页面不显示，请参阅 C2000Ware DigitalPower SDK 资源浏览器中 powerSUITE 下的“常见
问题解答”部分。

图图 17. Vienna 整整流流器器解解决决方方案案的的 powerSUITE 页页面面

http://www.ti.com.cn
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6.2 项项目目结结构构

图 18 显示了项目的总体结构。

图图 18. 项项目目结结构构概概览览

注注: 图 18 显示了用于 F2837x 的项目；不过，如果从 powerSUITE 页面中选择了不同的器件，结
构是类似的。

特定于解决方案并且独立于器件的文件是 <solution>.c/h。特定于电路板并且特定于器件的文件是 <solution
>_hal.c/h。该项目的 main.c 文件包括 C 项目的主函数以及 ISR 框架，并在其他文件中调用例程。<solution
>_settings.h 文件包括解决方案所需的所有设置。

对于此设计，<solution> 是 vienna。

<solution>_clatask.cla 文件包含 CLA 任务定义。

可以通过单击列在项目浏览器下的 main.cfg 文件打开 powerSUITE 页面。powerSUITE 页面生成

<solution>_settings.h 文件。该文件是由 powerSUITE 页面生成的用于项目编译的唯一文件。用户不得手动

修改此文件，因为每次保存项目时 powerSUITE 会覆盖更改。

Kit.xml 和 solution.js 文件由 powerSUITE 在内部使用，也不允许用户进行修改。对这些文件进行的任何更

改都将导致项目无法正常运行。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf


Project Name 

[Build Configuration]

Device Support Files

Board & Device Specific Files with Drivers 

for this solution

Solution Specific Files

Settings File generated 

Graph Prop File for populating the Graphs in 

CCS
XML Files generated by powerSUITE page (Do Not Modify)

Java Script File used by powerSUITE (Do Not Modify)

Target Configuration for debugger connection

Include File paths for different 

components in the project 

javaScript for populating the expressions window for 

different build levels

powerSUITE GUI Page

Main Function of the C project, ISR framework 

Digital Control Library Files

SFRA Files

CLA Files

www.ti.com.cn 固件入门

23ZHCU271E–November 2016–Revised June 2019

TIDUCJ0 — http://www-s.ti.com/sc/techlit/TIDUCJ0
版权 © 2016–2019, Texas Instruments Incorporated

基于 Vienna 整流器且采用 C2000™ MCU 的三相功率因数校正 (PFC) 参考设
计

导入项目后，CCS 内将显示项目浏览器，如图 19 所示。

图图 19. 解解决决方方案案项项目目的的方方案案浏浏览览器器视视图图

该项目包含一个在每个 PWM 周期中都会调用的中断服务例程，该例程称为 controlISR()，在其中执行控制

算法。除此之外，还有 A0-A4 和 B0-B4 后台任务，它们以轮询方式进行调用，可用于运行不要求绝对计时

精度的缓慢任务。将调用一个较慢的 10kHz 例程 tenkHzISR() 以用于检测，并运行一些需要计时精度的较

慢任务。

此设计指南中的软件以四个增量编译 (INCR_BUILD) 的方式进行组织。增量编译过程可以简化系统开发和设

计。

• INCR_BUILD 1：开环检查

• INCR_BUILD 2：闭合电流环路

• INCR_BUILD 3：闭合电压和电流环路

• INCR_BUILD 4：闭合电压、电流和总线电容平衡环路

下面一节中详细介绍了这些版本级别。如果使用设计指南硬件，请确保如5 节 中所述完成硬件设置。

http://www.ti.com.cn
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6.3 基基于于 C2000 MCU 使使用用 CLA 来来减减轻轻 CPU 负负载载

控制律加速器 (CLA) 是一款基于 C2000 MCU 系列器件提供的协处理器。利用该协处理器，可以从主 C28x
CPU 核心上卸载控制 ISR 函数。

要基于 CLA 运行控制 ISR，对于 powerSUITE 中支持的解决方案，可以通过 powerSUITE CFG 页面上的

下拉菜单实现选择。powerSUITE 解决方案的软件结构设计使得通过下拉菜单选择即可将任务卸载到 CLA
上。不会复制代码，仅维护解决方案算法的单源代码，即使代码在 CLA 或 C28x 上运行也是如此。利用该

配置，可以灵活地调试解决方案。

CLA 功能 在各个器件之间稍有不同，例如，在 F2837xD、F2837xS 和 F2807x 上，CLA 在给定的时间只能

支持一项任务并且没有嵌套功能，这意味着该任务是不可中断的。因此，实际上只能将一个 ISR 卸载到

CLA 上。在 F28004x 上，CLA 支持可以嵌套常规 CLA 任务的后台任务。利用该配置，可以将两个 ISR 卸

载到 CLA 上。

特定于器件的信息：

• F2837xD：CLA 任务不支持嵌套，因此只能将一个 ISR 卸载到 CLA 上。因此，仅将较快的 ISR（在该

设计上以 50kHz 的频率运行）卸载到 CLA 上。C28x CPU 上的 50kHz ISR 需要占用大约 20% 的 CPU
带宽，对于检测 ISR (10kHz)，会使用大约 4% 的 CPU 带宽。因此，总 CPU 利用率为 24%。利用该

CLA 选项，可以将该 CPU 负载降低至 4%。

• F28004x/F2838xD：CLA 支持可以嵌套 CLA 任务的后台任务。利用该配置，可以将两个 ISR 函数卸载

到 CLA 上。因此，对于 F28004x/F2838xD，控制 ISR (50kHz) 和检测 ISR (10kHz) 都将卸载到 CLA
上。在 F28004x 上，CPU 利用率对于 50kHz 循环大约为 40%，对于 10kHz 循环大约为 8%。因此，总

CPU 利用率大约为 48%。利用该 CLA 选项，在两个 ISR 都卸载到 CLA 上时，可以将 CPU 负载降低至

0%。

有关 CLA 的更多信息，请访问 CLA 实践技术讲座以及相应的器件技术参考手册。

http://www.ti.com.cn
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6.4 运运行行项项目目

注注: 与代码中的实际名称不同，用户指南中提到的变量名是简化的。例如，VIENNA_guiVbus_
Volts 可简化为 guiVbus。

6.4.1 INCR_BUILD 1：：开开环环

在此版本中，电路板以开环方式运行（采用固定占空比）。占空比通过 dutyPU_DC 变量进行控制。该生成

验证来自功率级的反馈值感应以及 PWM 栅极驱动器的运行，从而确保没有硬件问题。此外，可以在该生成

中执行输入和输出电压感应校准。图 20 中显示了该生成的软件结构。对以较慢的 ISR 运行的块进行了标

记。其他块以快速 controlISR 运行。

图图 20. 版版本本级级别别 1 控控制制软软件件图图：：开开环环项项目目

6.4.1.1 设设置置 BUILD 1 的的软软件件选选项项

1. 确保如5.1 节中所述设置硬件。请勿向电路板提供任何高压 (HV) 电源。对于该生成，将三相电源的中性
点连接到电路板（图 16）。

2. powerSUITE 设置 - 在项目选项 部分下的 powerSUITE 页面上：

选择开环 作为版本级别。

如果这是经调整的解决方案，请针对在每种情况下使用的感应电阻器编辑 ADC 感应参数 下的设置。指定开

关频率、死区和额定功率。保存该页面。

http://www.ti.com.cn
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6.4.1.2 生生成成和和加加载载项项目目

1. 右键单击项目名称，然后单击重构项目。

2. 将成功生成项目。

3. 在项目浏览器 中，确保在 tragetconfigs 项下将正确的目标配置文件设置为“有效”（图 19）。

4. 然后，单击运行 → 调试。这会启动调试会话。对于双 CPU 器件，可能会显示一个窗口，可以在其中选
择执行调试所需的 CPU。在本例中，选择“CPU1”。

5. 然后项目将加载到器件上，同时 CCS 调试视图将变为有效状态。代码将在主例程开始处停止。

6.4.1.3 设设置置调调试试环环境境窗窗口口

1. 要在监视和表达式窗口中添加变量，请单击 View → Scripting Console 以打开脚本控制台对话框。在该
控制台的右上角，单击“打开”，然后浏览位于项目文件夹内的 setupdebugenv_build1.js 脚本文件。该脚
本文件将采用调试系统所需的相应变量填充监视窗口。单击监视窗口中的“连续刷新”按钮，持续更新控制
器中的值。监视窗口将如图 21 中所示。

图图 21. 版版本本级级别别 1 表表达达式式视视图图

http://www.ti.com.cn
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2. 可以通过查看图形窗口中的数据来验证电流和电压测量值。这些值记录在较慢的 10kHz 例程中。转到
Tools → Graph → DualTime，然后单击 Import 并指向项目文件夹中的 graph1.GraphProp 文件。该文
件将填充图形属性窗口。或者，用户可以输入值，如图 22 中所示。验证输入值后，单击 OK。CCS 将显
示两个图形。单击这些图形上的 Continuous Refresh。还可以通过导入 graph2.GraphProp 文件添加第
二组图形。

图图 22. 图图形形设设置置

6.4.1.4 使使用用实实时时仿仿真真

实时仿真是一项特殊仿真功能，允许在 MCU 运行时更新 CCS 内的窗口。该功能不但可实现图形和监视视

图更新，而且使用户能够改变监视或存储器窗口中的值，并且无需停止处理器即可查看这些更改对系统的影

响。

1. 通过将鼠标悬停在水平工具栏中的按钮上并单击 按钮启用实时模式。

2. 可能会显示一个消息框。如果这样，则选择 YES 以启用调试事件。这会将状态寄存器 1 (ST1) 的位
1（DGBM 位）设置为 0。DGBM 是调试使能屏蔽位。当 DGBM 位设置为 0 时，存储器和寄存器值将传
递到主机处理器以更新调试器窗口。

6.4.1.5 运运行行代代码码（（生生成成 1））

1. 通过单击 运行项目。

2. 在监视视图中，定期查看是否更新了 guiVbus（VIENNA_guiVbus_Volts，在表达式窗口中）变量。如果
值没有变化，则确保已启用实时模式并且已正确设置硬件。除非已验证更新，否则不要执行进一步的操
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作。

• 注意：由于现在未通电，因此该值将接近于零。

3. 现在，缓慢增大输入交流电压（从 0 到 120Vrms L-N）。

4. 验证电压感应：确保 guiVbus、guiVbusPM 和 guiVbusMN 显示正确的值。对于 120Vrms L-NguiVbus
的值将接近于 320V，且 guiVbusPM/MN 的值将分别接近于 160V。代码运行正弦分析仪模块，该模块计
算电压和电流的 RMS 值。请注意，guiVrms1/2/3 的值将接近于输入值，即 120Vrms。这就实现了对电
路板的电压感应的验证。

5. 验证电流感应：请注意，对于给定的测试条件，guiIrms1/2/3 值将接近于 0.92 安培。此外，必须查看图
形以验证电流测量。在测试条件下，这些图形将如图 23 中所示。

图图 23. 版版本本级级别别 1：：显显示示测测量量的的电电压压和和电电流流的的 Graph1.GraphProp 和和 Graph2.GraphProp 文文件件

6. 图 24 中显示了输入电压和电流的示波器捕获。

图图 24. 版版本本级级别别 1：：PWM 跳跳闸闸情情况况下下的的示示波波器器捕捕获获 IL1、、IL2、、IL3 和和 V1 (120Vrms L-N)

7. 接下来，为了验证 PWM 操作，首先将输入电压降至零，然后等待所有电压降至零。

8. 现在，在表达式视图中将 dutyPU_DC 设置为 0.5。
9. 接下来，通过向 clearTrip 写入 1 来清除 PWM 跳闸。

10. 缓慢增大输入电压并监视输入电流。占空比将提供升压操作。例如，当 Vac 为 30Vrms 时，在未启用开
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关的情况下，guiVbus 将约为 84V；在启用开关的情况下，guiVbus 将上升至 140V。因
此，guiVbusPM/MN 也将高于输入电压最大值。

11. 。在此版本所述的测试条件下，当输入电压达到 120Vrms L-N 时，guiVbus 将增至 600V 左
右，guiVbusPM/MN 将分别接近 300V，并且电流将接近 2.8Vrms。将显示表达式视图，如图 25 中所
示。确保所有变量都是准确的，即 guiVrms1/2/3、guiIrms1/2/3、guiPF1/2/3。如果任何变量与图 25 中
显示的值不一致，它会指向感应电路的一个硬件问题。图 26 中显示了示波器捕获。

图图 25. 版版本本级级别别 1：：包包含含功功率率测测量量的的表表达达式式视视图图

图图 26. 版版本本级级别别 1：：占占空空比比为为 0.5 的的示示波波器器捕捕获获 IL1、、IL2、、IL3 和和 V1 (120Vrms L-N)

12. 该检查在基本层面上验证 PWM 驱动器和硬件连接。

13. 将输入电压降至零，然后等待总线电压降至零。

14. 对该生成的检查到此就结束了，成功完成该生成后，会验证以下项目：

1. 电压和电流感应以及调节正确

2. controlISR 和 tenkHzISR() 中生成 1 代码的中断生成和执行

3. PWM 驱动器和开关

如果观察到任何问题，则可能需要仔细检查硬件，以消除所有生成问题，等等。

15. 现在可以停止控制器并且终止调试连接。

16. 在实时模式下，完全停止 MCU 需要执行两个步骤。首先，通过使用工具栏上的停止 按钮 ( ) 或使用
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目标 → 停止 停止处理器。然后通过单击 使 MCU 退出实时模式。最后，通过单击 对 MCU 进
行复位。

17. 通过单击终止调试会话（目标 → 终止所有）关闭 CCS 调试会话。

6.4.2 INCR_BUILD 2：：闭闭合合电电流流环环路路

在该生成 (BUILD 2) 中，内侧电流环路是闭合的，也就是说，使用电流补偿器 Gi 控制电感器电流。对该电

流补偿器的输出应用了直流总线和输出电压前馈，以生成逆变器的占空比，如公式 13 中所示。该操作可以

简化电流补偿器的受控体，并且可以使用比例 (P) 控制器来调节内侧电流的环路。我们已在3.2 节中得出了

电流环路的模型。

(13)
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如图 27 中所示完成该生成的软件图。

图图 27. 版版本本级级别别 2 控控制制软软件件图图：：闭闭合合电电流流环环路路

6.4.2.1 设设置置 BUILD 2 的的软软件件选选项项

1. 确保如5.1 节中所述设置硬件。请勿向电路板提供任何 HV 电源。对于该生成，将三相电源的中性点连接
到电路板，如图 16 中所示。

2. powerSUITE 设置：在项目选项 部分下的 powerSUITE 页面上，选择闭合电源环路 作为版本级别。保存
该页面。

3. 在控制环路设计 下，将自动选择用于电流环路调优的选项（调优 → 电流环路 → COMP1 → P）。现在

单击 Compensation Designer 图标 ( )。
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6.4.2.2 设设计计电电流流环环路路补补偿偿器器

1. 然后补偿设计器将以电流环路受控体模型启动，powerSUITE 页面中指定了相应的参数。然后可以更改
比例增益值，以确保稳定的闭环运行。可以通过观察补偿设计器中开环传递函数图上的增益裕量和相位
裕度来验证使用设计的补偿器时的系统稳定性，如图 28 中所示。

图图 28. 使使用用补补偿偿设设计计器器的的电电流流环环路路设设计计

2. 比例增益符合要求后，单击保存 COMP。这会将补偿器值保存到项目中。

• 注意：如果未从解决方案适配器中选择项目，则不允许对补偿器进行更改来设计自己的解决方案。通
过解决方案适配器选择解决方案。

3. 关闭补偿设计器并返回到 powerSUITE 页面。

注意：代码中的 P 增益设置为 2.0，该增益会提供具有可能看起来太小的裕量的 OL 图；不过，该增益已

经过调节，请记住设计的实际测量值，其中的测量增益稍低。因此，可以在不牺牲实际裕量的情况下对

补偿器应用较高的增益。
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6.4.2.3 生生成成和和加加载载项项目目以以及及设设置置调调试试

1. 右键单击项目名称，然后单击重构项目。将成功生成项目。单击 Run → Debug，这将启动调试会话。对
于双 CPU 器件，可能会显示一个窗口，可以在其中选择执行调试所需的 CPU。在本例中，选择
“CPU1”。然后项目将加载到器件上，并且 CCS 调试视图将变为激活状态。代码将在 main 例程的开始处
停止。

2. 要在监视和表达式窗口中添加变量，请单击 View → Scripting Console 以打开脚本控制台对话框。在该
控制台的右上角，单击 Open 浏览位于项目文件夹内的 setupdebugenv_build2.js 脚本文件。该文件将采

用调试系统所需的相应变量填充监视窗口。单击监视窗口中的 Continuous Refresh 按钮 ( )，以持续
更新控制器中的值。监视窗口将如图 29 所示。

图图 29. 版版本本级级别别 2：：闭闭合合电电流流环环路路表表达达式式视视图图

3. 通过将鼠标悬停在水平工具栏中的按钮上并单击 按钮启用实时模式。
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6.4.2.4 运运行行代代码码（（版版本本 2））

1. 通过单击 运行项目。

2. 首先以低电压进行测试是可取的做法。因此，输入交流电压仅上升到 40Vrms (60Hz)。
3. 输入电流和电压将如图 30 所示。

图图 30. 版版本本级级别别 2：：PWM 跳跳闸闸情情况况下下的的示示波波器器捕捕获获 IL1、、IL2、、IL3 和和 V1 (40Vrms L-N)

4. 通过在表达式视图中更改 iLRef 变量设置电流基准。该变量设置为 0.05。
5. 通过将 clearTrip 变量设置为 1 来清除跳闸。

6. 一旦清除跳闸，就会看到从输入消耗正弦电流，这证明电流环路的运行是正常的。波形将如图 31 所示。

图图 31. 版版本本级级别别 2：：电电流流环环路路闭闭合合情情况况下下的的示示波波器器捕捕获获 IL1、、IL2、、IL3 和和 V1 (40Vrms L-N)

7. guiVbus 将接近于 190V，并且每相输入交流电流将接近于 0.6 安培。

8. 将电流基准 iLRef 增加至 0.1。观察总线电压变为 266V，输入电流变为大约 1.2 安培。

9. 现在，将输入交流电压缓慢增大至 120Vrms。在输入电压增大时，电路板将使输入电流保持恒定。
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10. 当输入稳定至 120Vrms，提高 iLRef，从而使 guiVbus 为 600V；对于指定的测试条件，这将对应于
iLRef = 0.165。电流波形将如图 32 所示。

图图 32. 版版本本级级别别 2：：电电流流环环路路闭闭合合情情况况下下的的示示波波器器捕捕获获 IL1、、IL2、、IL3 和和 V1 (120Vrms L-N)

11. 由于仅在补偿器中使用了一个比例增益，因此电流基准减去反馈误差绝不为零。请注意，消耗的电流会
稍微偏离基准。

12. SFRA 集成在该生成的软件中，通过在硬件上进行测量来验证设计的补偿器是否可以提供足够的增益裕
量和相位裕度。要运行 SFRA，请保持项目运行，然后在 cfg 页面中单击 SFRA 图标。SFRA GUI 将弹
出。

13. 在 SFRA GUI 上选择器件的相应选项。例如，对于 F28379D，选择“Floating Point”。单击 Setup
Connection。在弹出窗口中取消选中连接时引导选项，然后选择相应的 COM 端口。单击 OK。返回到
SFRA GUI，然后单击 Connect。
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14. SFRA GUI 将连接到器件。现在可以通过单击 Start Sweep 启动 SFRA 扫描。完成完整的 SFRA 扫描
需要几分钟的时间。可以通过查看 SFRA GUI 上的进度条以及检查控制卡背面用于指示 UART 活动的蓝
色 LED 闪烁情况来监视活动。完成后，将显示一个包含开环图的图，如图 33 中所示。这证明设计的补
偿器确实是稳定的。

图图 33. 在在闭闭合合电电流流环环路路上上运运行行的的 SFRA

频率响应数据也保存在 SFRA 数据文件夹下的项目文件夹内，并根据 SFRA 运行的时间打上时间戳。此

外，请注意测量的增益裕量和相位裕度接近于模拟值（请参阅图 34）。

图图 34. 电电流流环环路路的的模模拟拟 OL 响响应应与与测测量量 OL 响响应应

15. 再次单击 CFG 页面中的“补偿设计器”，然后针对 GUI 上的受控体选项选择 SFRA 数据。该选项将使用
测量受控体信息来设计补偿器，并且可用于微调补偿。默认情况下，补偿设计器将指向最近运行的
SFRA 并显示为图 35。如果需要使用运行的前一个 SFRA 受控体信息，则用户可以选择 SFRAData.csv
文件（通过单击 Browse SFRA Data 浏览该文件）。在完成该操作后，关闭“补偿设计器”以返回到 cfg
页面。
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图图 35. 包包含含测测量量的的受受控控体体频频率率响响应应数数据据的的补补偿偿设设计计器器

16. 该操作可验证电流补偿器设计。注意相位是否关闭，因为控制环路中有一个负号。

17. 要使系统安全停止，请将输入交流电压降至零，并且观察 guiVBus 也降至零。

18. 在实时模式下，完全停止 MCU 需要执行两个步骤。首先，通过使用工具栏上的停止 按钮 ( ) 或使用

目标 → 停止 停止处理器。然后通过单击 使 MCU 退出实时模式。最后，将 MCU 复位 ( )。
19. 通过单击 Terminate Debug Session (Target → Terminate all) 关闭 CCS 调试会话。

6.4.3 INCR_BUILD 3：：闭闭合合电电压压和和电电流流环环路路

在该生成中，在内侧电流环路闭合的情况下，外侧电压环路是闭合的（在 BUILD 2 中设计）。我们已在图

36 中得出了外侧电压环路的模型。我们使用了基于 PI 的补偿器，并通过补偿设计器对其进行调优。图 36
显示了该生成的软件图。
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图图 36. 版版本本级级别别 3 控控制制图图：：使使用用内内侧侧电电流流环环路路进进行行输输出出电电压压控控制制

图图 37. 版版本本级级别别 3 控控制制图图：：使使用用内内侧侧电电流流环环路路进进行行输输出出电电压压控控制制

6.4.3.1 设设置置 BUILD 3 的的软软件件选选项项

1. 确保如图 16中所述设置硬件。请勿向电路板提供任何 HV 电源。对于该生成，将三相电源的中性点连接
到电路板（图 16）。

2. 在项目选项 下，选择闭合电压和电流环路。

3. 在控制环路设计 下，选择作为电压环路 进行调优。样式将预设为 PI。按 Ctrl + S 保存该页面，然后单击

“Compensation Designer”按钮 ( )。
4. 确保在 powerSUITE cfg 页面中正确输入在板的输出端连接的负载，因为该负载值用于电压补偿器的设

计。
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6.4.3.2 设设计计电电压压环环路路补补偿偿器器

1. 然后补偿设计器将以电压环路受控体模型启动，如图 38 中所示。可以对 PI 补偿器进行编辑，以获取所
需的增益裕量和相位裕度，同时请记住，电压环路的带宽与实现的 THD 之间具有反向关系。通常，在
PFC 应用中，该带宽保持在大约 10Hz。

图图 38. 使使用用补补偿偿设设计计器器进进行行电电压压环环路路 PI 补补偿偿调调优优

2. 补偿器设计符合要求后，单击保存 COMP。这会将补偿器值保存到项目中。

• 注意：如果未从解决方案适配器中选择项目，则系统将不允许对补偿器进行更改。要设计自己的补偿
器，请通过解决方案适配器选择解决方案。

3. 关闭补偿设计器并返回到 powerSUITE 页面。使用 Ctrl + S 进行保存。
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6.4.3.3 生生成成和和加加载载项项目目以以及及设设置置调调试试

1. 右键单击项目名称，然后单击重构项目。将成功生成项目。单击 Run → Debug，这将启动调试会话。对
于双 CPU 器件，可能会显示一个窗口，可以在其中选择执行调试所需的 CPU。在本例中，选择
“CPU1”。然后项目将加载到器件上，并且 CCS 调试视图将变为激活状态。代码将在 main 例程的开始处
停止。

2. 要在监视和表达式窗口中添加变量，请单击 View → Scripting Console 以打开脚本控制台对话框。在该
控制台的右上角，单击 Open 浏览位于项目文件夹内的 setupdebugenv_build3.js 脚本文件。该文件将采

用调试系统所需的相应变量填充监视窗口。单击监视窗口中的 Continuous Refresh 按钮 ( )，以持续
更新控制器中的值。
监视窗口将如图 39 中所示。

图图 39. 版版本本级级别别 3：：表表达达式式视视图图

3. 通过将鼠标悬停在水平工具栏中的按钮上并单击 按钮启用实时模式。
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6.4.3.4 运运行行代代码码（（版版本本 3））

1. 通过单击 运行项目。

2. 将输入交流电压增大至 120Vrms VL-N 或 208Vrms VL-L (60Hz)。
3. 直流电压基准通过变量 vBusRef 进行设置。该值设置为 1.32，在该设计中该值对应于 600V。有关详细

信息，请参阅 calculations.xls 工作表。

4. 通过将 clearTrip 变量设置为 1 来清除跳闸。然后总线电压将增大至 600V。
5. 可以通过比较表达式窗口中的 vBusRef 和 vBusMeas 来验证闭环运行，如图 40 中所示。

图图 40. 版版本本级级别别 3：：表表达达式式窗窗口口

6. SFRA 集成在该生成的软件中，通过在硬件上进行测量来验证设计的补偿器是否可以提供足够的增益裕
量和相位裕度。要运行 SFRA，请保持项目运行，然后在 cfg 页面中单击 SFRA 图标。SFRA GUI 将弹
出。

7. 在 SFRA GUI 上选择器件的相应选项。例如，对于 F28379D，选择“Floating Point”。单击 Setup
Connection，然后在弹出窗口中取消选中连接时引导选项并且选择相应的 COM 端口。单击 OK。返回到
SFRA GUI，然后单击“Connect”。
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8. SFRA GUI 将连接到器件。现在可以通过单击 Start Sweep 启动 SFRA 扫描。完成完整的 SFRA 扫描需
要几分钟的时间。可以通过查看 SFRA GUI 上的进度条和检查控制卡背面用于指示 UART 活动的蓝色
LED 闪烁情况来监视活动。完成后，将显示一个包含开环图的图，如图 41 中所示。该操作证明设计的
补偿器确实是稳定的。

图图 41. 在在闭闭合合电电压压环环路路上上运运行行的的 SFRA

频率响应数据也保存在 SFRA 数据文件夹下的项目文件夹内，并根据 SFRA 运行的时间打上时间戳。
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请注意测量的增益裕量和相位裕度接近于模拟值，如图 42 中所示。

图图 42. 电电压压环环路路模模拟拟与与测测量量比比较较

9. 再次单击 CFG 页面中的“补偿设计器”，然后针对 GUI 上的受控体选项选择 SFRA 数据。该选项使用测
量的受控体信息来设计补偿器，如图 43 中所示。该选项可用于微调补偿。默认情况下，补偿设计器将指
向最近运行的 SFRA。如果需要使用 SFRA 之前运行的受控体信息，则用户可以选择 SFRAData.csv 文
件（通过单击浏览 SFRA 数据 浏览该文件）。完成后，关闭“补偿设计器”以返回到 cfg 页面。

图图 43. 使使用用测测量量的的受受控控体体信信息息设设计计的的电电压压环环路路补补偿偿

10. 这可以验证电压补偿器设计。

11. 要使系统安全停止，请将输入交流电压降至零，并且观察 guiVBus 也降至零。

12. 在实时模式下，完全停止 MCU 需要执行两个步骤。首先，通过使用工具栏上的停止 按钮 ( ) 或使用
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目标 → 停止 停止处理器。然后通过单击 使 MCU 退出实时模式。最后，将 MCU 复位 ( )。
13. 通过单击终止调试会话（目标 → 终止所有）关闭 CCS 调试会话。

6.4.4 INCR_BUILD 4：：闭闭合合平平衡衡、、电电压压和和电电流流环环路路

在该生成中，电路板作为三线系统运行，即电源的中性点未连接到输出的直流中点。为了使直流总线保持平

衡，在控制结构中添加了一个具有简单比例增益的平衡环路，如图 44 中所示。在该生成中，还执行了第三

个谐波注入，这可以帮助稳定直流总线平衡点。

图图 44. 版版本本级级别别 4 控控制制图图：：输输出出电电压压、、电电感感器器电电流流和和总总线线电电容容平平衡衡环环路路
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6.4.4.1 设设置置 BUILD 4 的的软软件件选选项项

1. 确保已设置硬件，如图 45 中所示。与以前的生成相比，一个主要的区别是，中性点不再连接到直流总线
电容器的中点。

图图 45. 版版本本级级别别 4 硬硬件件设设置置图图

2. 在项目选项 项下的 powerSUITE 页面中，选择闭合的电压、电流和总线电容平衡环路。

3. 保存该页面。
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6.4.4.2 生生成成和和加加载载项项目目以以及及设设置置调调试试

1. 现在，右键单击项目名称，然后单击重构项目。将成功生成项目。单击 Run → Debug；这将启动调试会
话。对于双 CPU 器件，可能会显示一个窗口，可以在其中选择执行调试所需的 CPU。在本例中，选择
“CPU1”。然后项目将加载到器件上，并且 CCS 调试视图将变为激活状态。代码将在 main 例程的开始处
停止。

2. 要在监视或表达式窗口中添加变量，请单击 View → Scripting Console 以打开脚本控制台对话框。在该
控制台的右上角，单击“打开”浏览位于项目文件夹内的 setupdebugenv_build4.js 脚本文件。该文件将采

用调试系统所需的相应变量填充监视窗口。单击监视窗口中的连续刷新 按钮 ( )，持续更新控制器中的
值。监视窗口将如图 46 中所示。

图图 46. 版版本本级级别别 4：：表表达达式式视视图图

3. 通过将鼠标悬停在水平工具栏中的按钮上并单击 按钮启用实时模式。
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6.4.4.3 运运行行代代码码（（版版本本 4））
1. 通过单击运行项目。

2. 将交流输入增大至 120Vrms VL-L 和 208Vrms VL-L (60Hz)。将以接近于 0.7 的 PF 从输入消耗整流电
流，如图 47 中所示。

图图 47. 版版本本级级别别 4：：PWM 跳跳闸闸情情况况下下的的示示波波器器捕捕获获 IL1、、IL2、、IL3 和和 V1 (120Vrms L-N)

3. 总线电压通过变量 vBusRef 设置为 1.32，在该设计中该值对应于 600V。
4. 通过向 clearTrip 变量写入 1 来启动 PFC 操作。

5. 电路板现在将消耗正弦电流，PF 将接近于 0.99，THD 将大约为 2.5%。示波器捕获将如图 48 中所示。

图图 48. 版版本本级级别别 4：：全全 PFC 生生成成下下的的示示波波器器捕捕获获 IL1、、IL2、、IL3 和和 V1 (120Vrms L-N)

6. 直流总线电压也将得到平衡，即 guiVbusPM 和 guiVbusMN 几乎是相等的，这表明闭环平衡控制器正常
工作。

7. SFRA 集成在该生成的软件中，通过在硬件上进行测量来验证设计的补偿器是否可以提供足够的增益裕
量和相位裕度。要运行 SFRA，请保持项目运行，然后在 cfg 页面中单击 SFRA 图标。SFRA GUI 将弹
出。

8. 在 SFRA GUI 上选择器件的相应选项。例如，对于 F28379D，选择“Floating Point”。单击“Setup
Connection”，然后在弹出窗口中取消选中连接时引导选项并且选择相应的 COM 端口，然后单击 OK。
返回到 SFRA GUI，然后单击 Connect。

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf


固件入门 www.ti.com.cn

48 ZHCU271E–November 2016–Revised June 2019

TIDUCJ0 — http://www-s.ti.com/sc/techlit/TIDUCJ0
版权 © 2016–2019, Texas Instruments Incorporated

基于 Vienna 整流器且采用 C2000™ MCU 的三相功率因数校正 (PFC) 参考设
计

9. SFRA GUI 将连接到器件。现在可以通过单击 Start Sweep 启动 SFRA 扫描。完成完整的 SFRA 扫描需
要几分钟的时间。可以通过查看 SFRA GUI 上的进度条以及检查控制卡背面用于指示 UART 活动的蓝色
LED 闪烁情况来监视活动。完成后，将显示一个包含开环图的图，如图 49 中所示。该图证明设计的补
偿器确实是稳定的。

图图 49. 在在平平衡衡电电压压环环路路上上运运行行的的 SFRA

10. 平衡环路开环增益通过变量 Gs_GainKp 进行控制，并且可以在 BW 不够时进行调节。不过，对于平衡
环路，带宽需要低于外侧电压环路，仅 1 至 2Hz 带宽就足够了。

11. 在实时模式下，完全停止 MCU 需要执行两个步骤。首先，通过使用工具栏上的停止 按钮 ( ) 或使用

目标 → 停止 停止处理器。然后通过单击 使 MCU 退出实时模式。最后，将 MCU 复位 ( )。
12. 通过单击终止调试会话（目标 → 终止所有）关闭 CCS 调试会话。

。

6.4.5 根根据据 HTTP GUI 页页面面和和以以太太网网支支持持（（仅仅 F2838x））监监测测和和控控制制 Vienna 整整流流器器。。

本部分将综合介绍以太网支持和 Vienna 整流器。基于以太网的监控可应用于所有四个增量编译，基于以太

网的控制可应用于 INCR_BUILD 3 和 INCR_BUILD 4。本部分的测试建立在 INCR_BUILD 4 基础上。
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6.4.5.1 系系统统配配置置

图图 50. Vienna PFC 和和以以太太网网配配置置

此测试包含两种数据流，如图 50 中所示。在参数监控流程中，在 HTTP GUI 页面上监控和显示三相电流、

电压和功率因数。在控制命令流程中，输出电压基准和命令信号（启动 PFC - cleartrip）可在 GUI 页面上设

置，并控制 Vienna 整流器。

6.4.5.2 测测试试设设置置

图图 51. Vienna PFC 和和以以太太网网测测试试配配置置

根据 图 51
1. 准备两台笔记本电脑：CCS 在 PC1 上运行。PC2 通过 GUI HTTP 页面控制和监测 PFC。

2. 确保硬件设置与 INCR_BUILD 4 相同。使用以太网电缆将 PC2 连接至 TMDSCNCD28388D 控制卡的端
口 J4（以太网连接器 – RJ45 连接器）。

3. 将 PC2 的网络设置更改为启用静态 IP，并将静态 IP 地址配置成 192.168.0.7（除 F2838x IP 地址
192.168.0.4 外的任何地址均可）

6.4.5.3 测测试试规规程程

1. 执行第 6.4.4.1 节的步骤 1~3
2. 打开“vienna_settings.h”，将设置从“#define ETHERNET_DEMO ETHERNET_DISABLED”更改为“#

define ETHERNET_DEMO ETHERNET_ENABLED”。单击“保存”。这样，GUI 页面可通过以太网发送
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命令信号。（注意：如果未使用以太网并选择常规 INCR_BUILD 4，不要忘记将设置更改为原设置）

3. 执行第 6.4.4.2 节的步骤 1~2
4. 连接 CM 内核并将 enet_lwip_cm.out 加载至 CM 内核。enet_lwip_cm.out 位于文件夹 c2000ware-

digital-power-sdk\solutions\tidm_1000\f2838x\enet_lwlp_cm\examples\enet_lwip\cm\ccs\Flash 中。注
意：不建议更改 enet_lwip_cm.out 文件。然而，如果客户想要更改，那么需要在 CCS 中单独打开项目
(c2000ware-digital-power-sdk\solutions\tidm_1000\f2838x\enet_lwlp_cm\examples\enet_lwip)，而且需
要将 driverlib (c2000ware-digital-power-sdk\c2000ware\driverlib\f2838x\driverlib_cm) 添加至项目重新编
译。

5. 单击“德州仪器 (TI) XDS100v2 USB 调试 Probe_0/C28xx_CPU1”并单击运行

6. 单击“德州仪器 (TI) XDS100v2 USB 调试 Probe_0/C28xx_CPU1”并单击停止

7. 通过将鼠标悬停在水平工具栏中的按钮上并单击 按钮启用实时模式。

8. 单击“德州仪器 (TI) XDS100v2 USB 调试 Probe_0/C28xx_CPU1”并单击运行

9. 单击“德州仪器 (TI) XDS100v2 USB 调试 Probe_0/Cortex_M4_0”并单击运行

10. 在 PC2 上打开 Web 浏览器 (Chrome/IE)，将 TMDSCNCD28388D 控制卡连接至 PC2 并键入
192.168.0.4。您会看到类似图 52 的 GUI 页面。

图图 52. TIDM-1000 的的以以太太网网 GUI 页页面面

11. 逐渐将输入电压增至 120V。检查表达式窗口的所有参数。单击“查询参数”，然后单击“刷新”以在网页上
显示参数。GUI 页面图 53 应显示所有参数。将这些数值与表达式窗口所示数值进行比较。确保 GUI 中
显示的所有参数均正确。在此步骤未完成验证前，不要进行下一步。
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图图 53. 启启动动 PFC 前前的的以以太太网网 GUI 页页面面

12. 现在，确认“参考 Vbus”是标幺值 1.32，且“Clear Trip”值为 1。单击“更新”按钮，启动 PFC。单击“查询
参数”，然后单击“刷新”以在网页上显示参数。如果一切正确，应按照图 54 更新所有参数。
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图图 54. 启启动动 PFC 后后的的以以太太网网 GUI 页页面面

13. 最后一步是将“参考 Vbus”更改为 1 并单击“更新”。输出电压应降低至 450V 左右。可选择其他小于 1.32
的“参考 Vbus”。
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6.4.6 基基于于 CLA 运运行行

该解决方案提供了基于 CLA 运行代码的选项。可以通过 powerSUITE main.cfg 页面上项目选项下的下拉框

来选择该选项。对于任何版本级别选项，均可选择基于 CLA 运行。

注注: SFRA 库不支持 CLA，因此在使用 CLA 时无法运行 SFRA。

在使用 CLA 时也不使用 DLOG，因此在使用 CLA 时数据记录图将不起作用。

更改选项后，必须保存 CFG 文件并重新编译项目。重新编译后，执行特定增量编译级别文档中所述的步

骤。

只能将一个 ISR 卸载到 CLA 上，具体取决于器件（例如对于 F2837x，CLA 仅支持不可嵌套的 CLA 任

务）。默认情况下，如果从 powerSUITE 页面中选择，则会将较快的 ISR 转移到 CLA 上。在该 TID 中，这

是 50kHz ISR。对于 F28004x 和 F2838x 等器件，CLA 支持可以嵌套 CLA 任务的后台任务。默认情况

下，50kHz 控制 ISR 和 10kHz 检测 ISR 都将卸载到 CLA 上。如果出于某种原因，用户不想在 CLA 上运行

10kHz ISR，那么 solutions-settings.h 文件中的“用户部分”提供了相关选项。

#if VIENNA_CONTROL_RUNNING_ON== CLA_CORE
#define VIENNA_INSTRUMENTATION_ISR_RUNNING_ON CLA_CORE
#else
#define VIENNA_INSTRUMENTATION_ISR_RUNNING_ON C28x_CORE
#endif
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7 测测试试和和结结果果

7.1 208V L-L 交交流流输输入入 (60Hz)、、600V 直直流流输输出出的的测测试试结结果果

7.1.1 启启动动

图 55 中显示了功率级的启动序列，其中输入为三相 208Vrms VL-L 并且输出总线稳定在 600V，负载为

612W。

图图 55. 208V 交交流流输输入入、、600V 直直流流输输出出和和 612W 负负载载下下的的 PFC 操操作作启启动动

7.1.2 稳稳态态条条件件

图 56 和图 57 中分别显示了 612W 和 1364W 不同负载条件下的稳态电流波形。

图图 56. 稳稳态态 208V 交交流流输输入入，，600V 直直流流输输出出，，612W，，iTHD 2.5%
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图图 57. 稳稳态态 208V 交交流流输输入入，，600V 直直流流输输出出，，1364W，，iTHD 0.96%

表 4 列出了 208V 交流输入、600V 直流输出时，该设计在各种负载条件下的详细测试结果。

表表 4. 208V 交交流流输输入入、、600V 直直流流输输出出和和各各种种功功率率级级别别下下的的详详细细测测试试结结果果

Vbus_PM Vbus_MN VoutTotal 引引脚脚 Iout Pout 效效率率 THD% PF
297.85 300.5 598.35 74 0.117 70.00695 0.946039865 23.20% 0.8263
298.58 300 598.58 124.4 0.2 119.716 0.962347267 17% 0.9206
299.12 299.8 598.92 245.1 0.4 239.568 0.977429621 8.09% 0.9777
299.78 299 598.78 481.3 0.788 471.83864 0.980342074 3% 0.994
299.52 299.6 599.12 623.7 1.022 612.30064 0.981723008 2.54% 0.9964
299.66 299.4 599.06 858.8 1.405 841.6793 0.980064392 1.71% 0.998
299.84 299.1 598.94 1001.6 1.637 980.46478 0.978898542 1.52% 0.9984
299.3 299.82 599.12 1150.6 1.878 1125.14736 0.977878811 1.22% 0.9988
300.13 298.8 598.93 1399.7 2.278 1364.36254 0.974753547 0.96% 0.999

图 58 显示了在这些测试条件下绘制的效率数据。

图图 58. 208V 交交流流输输入入和和 600V 直直流流输输出出下下的的效效率率
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图 59 显示了在这些测试条件下绘制的 THD 数据。

图图 59. 208V 交交流流输输入入和和 600V 直直流流输输出出下下的的 THD

图 60 显示了在这些测试条件下绘制的 PF 数据。

图图 60. 208V 交交流流输输入入和和 600V 直直流流输输出出下下的的 PF
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图 61 显示了在 208Vrms 输入、600V 直流输出和 1.2kW 负载条件下运行时电流谐波的电源分析仪捕捉。

图图 61. 在在 208V 交交流流输输入入、、600V 直直流流输输出出、、1.2kW 负负载载条条件件下下运运行行时时谐谐波波的的电电源源分分析析仪仪捕捕捉捉
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7.1.3 阶阶跃跃负负载载变变化化瞬瞬态态测测试试

PFC 级控制包含一个尝试跟随输入电压的内侧电流环路，以及一个尝试在输出端保持恒定直流总线电压的外

侧电压环路。因此，电压环路会与电流环路发生冲突，所以必须将电压环路设计为具有很低的带宽（大约

10Hz），以实现出色的功率因数。慢电压环路会在瞬态条件下出现显著的过冲和下冲，请参阅图 62 和图

63。

图图 62. 不不具具有有非非线线性性电电压压环环路路时时 1kW 瞬瞬态态条条件件下下的的电电压压过过冲冲

图图 63. 不不具具有有非非线线性性电电压压环环路路时时 1kW 瞬瞬态态条条件件下下的的电电压压下下冲冲

为了改善电压过冲和下冲，同时保持出色的功率因数，实施了非线性电压控制环路，如图 64 所示。
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图图 64. 具具有有迟迟滞滞功功能能的的非非线线性性电电压压环环路路

该非线性电压环路中添加了一个滞环，以避免在高增益和低增益模式之间产生振荡。此外，转换了增益更

改，以避免任何突然变化。图 65 和图 66 显示了具有非线性电压环路情况下的结果，与不具有非线性电压

环路的情况相比，过冲和下冲显著降低。

图图 65. 具具有有非非线线性性电电压压环环路路时时 1kW 瞬瞬态态条条件件下下的的电电压压过过冲冲

http://www.ti.com.cn
http://www-s.ti.com/sc/techlit/TIDUCJ0.pdf


测试和结果 www.ti.com.cn

60 ZHCU271E–November 2016–Revised June 2019

TIDUCJ0 — http://www-s.ti.com/sc/techlit/TIDUCJ0
版权 © 2016–2019, Texas Instruments Incorporated

基于 Vienna 整流器且采用 C2000™ MCU 的三相功率因数校正 (PFC) 参考设
计

图图 66. 具具有有非非线线性性电电压压环环路路时时 1kW 瞬瞬态态条条件件下下的的电电压压下下冲冲
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7.2 400V 交交流流输输入入 (50Hz)、、700V 直直流流输输出出的的测测试试结结果果

7.2.1 稳稳态态条条件件

图 67 和图 68 中分别显示了 960W 和 1865W 两种负载条件下的 400Vrms/50H 交流输入和 700V 直流输出

的稳态电流波形。

图图 67. 稳稳态态 400V 交交流流输输入入 (50Hz)，，700V 直直流流输输出出 960W，，iTHD 7%

图图 68. 稳稳态态 400V 交交流流输输入入，，700V 直直流流输输出出 1865W，，iTHD 3.5%

表 5 列出了各种负载条件下该设计的详细测试结果。

表表 5. 400V 交交流流输输入入、、700V 直直流流输输出出和和各各种种功功率率级级别别下下的的详详细细测测试试结结果果

Vbus_PM Vbus_MN VoutTotal 引引脚脚 Iout Pout 效效率率 THD% PF
349.41 351.2 700.61 101.9 0.137 95.98357 0.941938862 29.10% 0.7526
349.41 351.9 701.31 265.3 0.37 259.4847 0.978080286 22% 0.9309
349.43 352 701.43 581.9 0.819 574.47117 0.987233494 11.30% 0.9823
349.49 351.8 701.29 900.7 1.27 890.6383 0.988829022 7% 0.9922
349.46 351.9 701.36 1094.6 1.543 1082.19848 0.988670272 6.20% 0.9982
349.61 351.7 701.31 1354.1 1.913 1341.60603 0.990773229 5.20% 0.9964
349.64 351.4 701.04 1553.4 2.191 1535.97864 0.988785014 4.70% 0.9972
349.75 351.2 700.95 1884.4 2.66 1864.527 0.989453938 3.50% 0.998
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图 69 显示了在这些测试条件下绘制的效率数据。

图图 69. 400V 交交流流输输入入和和 700V 直直流流输输出出下下的的效效率率

图 70 显示了在这些测试条件下绘制的 THD 数据。

图图 70. 400V 交交流流输输入入和和 700V 直直流流输输出出下下的的 THD
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图 71 显示了在这些测试条件下绘制的 PF 数据。

图图 71. 400V 交交流流输输入入和和 700V 直直流流输输出出下下的的 PF

图 72 显示了以 2.4kW 功率运行该电路板时的热像仪图像。除浪涌电流控制热敏电阻之外，该电路板必须在

低于 60 摄氏度的温度下运行。图 72 显示了以 2.4kW 功率、高压线路 230Vrms L-N 输入电压和 700V 直流

总线输出电压运行时 Vienna 整流器板的热感图像。

图图 72. 以以 2.4kW 功功率率、、230Vrms VL-N 输输入入和和 700V 直直流流输输出出运运行行时时 Vienna 整整流流器器的的热热像像仪仪图图像像
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基于 Vienna 整流器且采用 C2000™ MCU 的三相功率因数校正 (PFC) 参考设
计

8 设设计计文文件件

请参阅位于 TIDM-1000 或位于 C2000Ware_DigitalPower_SDK/solutions/tidm_1000/hardware 的

DigitalPower SDK 包下的设计文件。

8.1 原原理理图图

要下载原理图，请参阅 TIDM-1000 中的设计文件。

8.2 物物料料清清单单 (BOM)

要下载 BOM，请参阅 TIDM-1000 中的设计文件。

8.3 PCB 布布局局建建议议

8.3.1 布布局局图图

要下载层图，请参阅 TIDM-1000 中的设计文件。

8.4 Altium 项项目目

要下载 Altium 项目文件，请参阅 TIDM-1000 中的设计文件。

8.5 光光绘绘文文件件

要下载光绘文件，请参阅 TIDM-1000 中的设计文件。

8.6 装装配配图图

要下载装配图，请参阅 TIDM-1000 中的设计文件。

9 软软件件文文件件

要下载软件文件，请参阅 C2000Ware DigitalPower SDK 中的设计文件。安装后，可以在以下位置找到参考

设计：

• C2000Ware_DigitalPower_SDK\solutions\tidm_1000\

– \docs > 文档

– \hardware > PCB Altium 项目、Gerbers、BOM、sense_calculation.xlsx

– \<device>

• <pfc3phvienna> > CCS 项目

10 相相关关文文档档

1. Hartmann, M.、S.d. Round、H. Ertl 和 J.w. Kolar。"Digital Current Controller for a 1 MHz, 10 KW
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doi:10.1109/tpel.2009.2031437.
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3. 德州仪器 (TI)，《TMS320F2837xD 双核 Delfino™ 微控制器数据表》

4. 德州仪器 (TI)，《TMS320F28004x Piccolo™ 微控制器数据表》
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